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L ecture 4: Cadence

CSCE 5730
Digital CMOS VLSI Design

Instructor: Saraju P. Mohanty, Ph. D.

NOTE: The figures, text etc included in slides are borrowed
from various books, websites, authors pages, and other
sources for academic purpose only. The instructor does
not claim any originality.
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Lecture Outline

 |n this tutorial we will learn using the following
— The Cadence® ICFB Environment and Tools
— Creating Library, Cellview in Library Manager
— The Virtuoso Schematic Editor
— Cadence Analog Design Environment
— The Calculator Tool
— Parametric Analysis

UNMRSITY L |
NORTH EXAS CSCE 5730: Digital CMOS VLSI Design

¢



Cadence® ICFB

¢ CygwiniX X [=1[e3

Custom 1C Design Tools
Front to Back Design Environment

Copyight @ 1'3'24"' 2004 Cadence Desian System I All rights v :I. Caden :Iﬂ'
Cadence laga o 1 :H'r :I iarks. II et |: aper erfies Tﬂ' wsper 11 I' | d et

e The Cadence® ICFB environment is a set of
— “Custom IC Design Tools".

* |t gives a complete
— “Front to Back Design Environment”
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Initiating the ICFB Environment

ELIASK - X-Win32

%  valmiki@ Inx-eliask:~/VerilogA

File Edit View Terminal Go Help

[valmiki@lnx-eliask valmiki]$ cd veriloga
[valmiki@lnx-eliask VerilogaAl$ env | grep IM
LM_LICENSE_FILE=5280@8eng-cadsun.eng.unt.edu
[valmiki@lnx-eliask VerilogAl$ icfb &

[1] 15059

[valmiki@lnx-eliask VerilogAl§ []

i .icfb - Log; /usr1/home/valmiki/CDS .log i R L=}
File Tools Options Help 1

}ioading vars from .classEnv for tool asimenw
Done with Class Initialization.
r;’Warrur’ng Cannot convert string "-adobe-helvetica-medium-r-normal--0-100-75-75-p-0-15088559-1" to type ||

mouse L

ICFB Command interpreter window
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Launching Library Manager

Choose Library Manager
from the “Tools” menu

Conversion Tool Box...
/ Library Manager...
Library Path Editor...
Verilog Integration
VHDL Tool Box...
S3ynopsys Integration...
Router
Constraint Manager...
Mized Signal Environment
Analog Environment
Sprlivin

Technology File Manager...
Display Resource Manager...
CDF

AMS

Camera

ic SKILL Development... 1S.log -

File Tools | Options Help | 1

loading wars from . classEnv for tool asimenw
Done with Class Initialization.
Warning: Cannot convert string "-adobe-helwetica-medivm-r-normal--0-100-75-75-p-0-1508859-1" to type

]: —
mouse Lo M: R:

»
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CADENCE - Library manager

Manager: WorkArea;
Fle Edit View Design Manager Help
1 Show Categories 1 Show Files
— Library Cell View
analogLib i i
ahdlLib MOS_afd A |
ahdl debug MOS_dZa
analogLib TTL_aZd
hasic TTL_dZa
cdsDefTechLib bes
class bws
examples cap
functional CCCS
iccd2005 cocosd
pllLikb cCCws
sample cowsd
solutions cidmprobe
spice Core
test corefragment
training delay
diode
dummsy
fourier
fourierZch
g
grda
orudd
Llam
idc
ideal halun
lexp
ind
1opamp
iprobe
A
_l_
— Messages
but was defined in libFile ° /usrcl/home/valmiki/Veriloghscds.lib® for Lib ‘tests’. —
Log file is "fusrl/hemes/valmiki/Verilogad/libManager. lag". B
L= .
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Creating a New Library - 1

] “" | Library Manager: WorkArea: fusrl/home/valmiki/VerilogA

- 0 X

File Edit View Design Manager

Help

[Mew " [ubrary...

1 ST " s e
SR el Ve cell View

Gpen {Bead - DHiVE 7 catsgory . |?

Load Defaults...
Save Defaults...

Open Shell Window  ~p
i

Exit
class
examples
functional
iccd2005
pllLib
sample
solutions
spice
test
training

— Messages

but was defined in libFile * srcl/home/walmiki Verilogh/cds.1lib* for Lib ‘tests’.
Log file is " usrcl/homewalmiki VeriloghlibManager. log".

=1

File > New - Library
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Creating a New Library - 2

« 1.Choose the directory
where you want to place
e your library/tools

- « 2. Name the library
e Hit OK

Directory

Models
MultiKSimulation
TahMod
eliaskDatsFlots
include
simulation

Asrl home Aralmiki Verilogk

Design Manager
Pan HONE

iine Pl iRR4

OK Apply Cancel Help

=
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Creating a New Library - 3

Library Manager: WorkArea: jusrl/home/valmiki/VerilogA

Bl Fle Edit View Design Manager Help
]
Show Categories Show Files
]
Library Cell Views

Fecdzoos ? ?

zhdlLib and2

ahdl debug i

analogLib nMas

hasic nand2

cdsDefTechLib nor

class ora

examples random_nand2

functional

iccd2oos 0K | Cancel Help

pllLihb

sample Technology File for library "tutorial”

solutions

spice If you will be creating mask layout or

test other physical data in this library, you

ErEamemgy will need a technology file. If you plan
tutorial )
1o use only schematic or HDL data, a
technology file is not required.
You can: Compile a new techfile
fittach to an existing techfile
4 Don’t need a techfile
Messages

Warning: The directory: */uscl/homefeliask/Veriloga/tests® does not exist
but was defined in 1ibFile ' /oscl/home~almiki Weriloghscds. ik for Lib ‘tests’.

As and when required, associate a “techfile” with your library.
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Creating a New Library - 4

Manager: WorkArea: fusrlifhome/va

File Edit View Design Manager Help

& Show Categories _| Show Files

— Library Category Call View

Trutorial

ahdlLib

ahdl debug
analogLib
basic
cdsDefTechLikb
class
examples
functional
iced2005
pllLib
samp le
solutions
spice
test
trainin
tutori

i
Messages
Warning: The directory: */usrl/homeseliask/Verilogh/ tests® does not exist —
but was defined in 1libFile * Aasrclshome~almikiVerilogascds. ik’ for Lib ‘tests’
—
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Creating a Cell View

Library Manager: WorkArea: fusrl/home/valmiki/VerilogA

Fle Edit View Design Manager Help

Hew Library...
bt B "% cell Views...
Open {Road-Onlyy 0 category...
Load Defaults...

Save Defaults...

tegory View

Open Shell Window  “p

Exit =
class
examples
functional
iccd2005
pllLib
sample
solutions
spic
test
training OK Cancel | Defaults Help
tutorial
. tutorial

Library MHame

Cell Name Bt

View Mame schematic

Composer- Schematic
Tool
Messages Uhl"ﬂ.l"y" []Elth file

Warning: The directao fusrlhome feliask/Verilogh/tests’ ¢ 1k i 1 ]
o d butewas de flngd 1nu]3_ hFi lme ,-"usai"h me,-"va]g_m ki /Wer ;l] fuarlmDmEfvaMIklwerl]ﬂ!:lgﬂfl-l:ds' llb l

Choose your library, and then create a new Cell View as follows:

File = New - Cell View,
Cell Name - NAND2, View Name - Schematic, Tool = Composer
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Virtuoso Schematic Editor

2% Virtuoso® Schematic Editing: tutorial NAND2 schematic
Cimnd: sel: 0

Tools Design Window Edit Add Check Sheet Options

] J k |mouse L: schSingleSelectPt() M: schHiMowsePoplp () F: ddsOpenLibManauger ()

Virtuoso Schematic Editor Window
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Adding an Instance of a Cell

»% Add Instance EI @| g|

B’ Hide Cancel | Defaults Help
Library Browse

%} Cell

(-i-f View symbol

.2 Names | .

Sy : : Click Browse to get

1 1 -
ey fows [+ Columns | the Library Browser
-[::;O- Sideways Upside Down
j Various shortcuts to common commands such are

7 . .

~ available in the left toolbox:

a % 1. placing component instances,

2. drawing wires,

3. placing ports etc.
Instance

) \ Short pop-up help messages can be obtained by
putting the mouse on top of the icons.
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Adding an Instance - 2

Virtuoso® Schematic Editing: tutorial NAND2 schematic

Cmd: Add Instance 2
Tools D| Hide Cancel | Defaults Help Help
B/ Library | analogLikf Browse
@ Cell rmosd

View i
@2

N Hames
&2 : ;

= Array Rows L Columns | L
_[:i& Rotate Sideways Upside Down Show Categories
S Library Cell View

odel name
)‘)/- o - S ahdlLib n2port ams
Multiplier T ahdl debu n3port aucdl
7 analoglib ndport aulvs
(_\L Width N |basic nbsin cd=Spice
H cd=DefTeck nbsind hepiceD
Length I (|| class njfet hspices
Drain diffusion area exanp Les EULSS spectre
_ . functional e 54 spectres
Z E Source diffusion area A icecd2005 nmos symbal

K

pllLih oS

Drain diffusion periphery

L;

Source diffusion periphery

Drain diffusion res sguares

L
#

Source diffusion res sguares |

i
o

(/[ & B

Drain diffusion length
Source diffusion length

Temp rise from ambient

Estimated operating region

Hot-electron degradation i) R: Rotate 30
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Adding an Instance - 3

Virtuoso® Schematic Editing: tutorial NAND2 schematic
Cmd: If v | Add Instance
Tools Dl Hide Cancel | Defaults Help

Library analogLik Browse

cell rmosd

View synhol;

Mames |

Array Rows 1« Columns 1=

Rotate Sideways Upside Down

Model name Show Categories

Multiplier Library Cell View

Width fnalogLib mosd Tesmibol
ahdlLib niport ams

RENHE ahdl_dekus niport auCdl

Drain diffusion area oslealit T EELES
basic nhsim cdsSpice

Source diffusion area cdsDefTect nhsind hspiceD
class njfet hspices

Drain diffusion periphery examples e s spectre

g functional e 54 spectres
Source diffusion periphery iced2005 nmos symhol
H 11Lih 4

Drain diffusion res squares . P s

Source diffusion res squares .

Drain diffusion length

Source diffusion length

Temp rise from ambient

Estimated operating region

Hot-electron degradation F: Rotate d0

When the view is selected from the library
It is automatically placed in the schematic

UNIVERSITY,
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When the mouse is
moved on top of the
Virtuoso Schematic
window an "outline"
of the transistor can
be seen.

The outline can be
moved, rotated,
flipped this outline,
then by clicking the
left-mouse button it
can be placed in the
schematic.

Multiple ones at a
time can be put if
required number of
transistors are known
ahead of time by
specifying the
number of rows and
columns.
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Adding an Instance - 4

050E Sch

ruo s¢ ematic bditing:
Cmd: Instance Sel: 0

Tools Design Window Edit Add Check Sheet Options Help

O ouzse L: mouse AddPt() M: schHiMousePopUp ()
1= = | Point at location for the instance.

If any mistake occurs just

LE;\ mouse L schSingleSelectPti) M: schHiMousePoplp () E: schHiEditInFlace ()
= =

Edit = Undo and try again.

ESC key on the keyboard gets us As many instances as possible can be
out of the place instance mode added to the schematic
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Connecting Components

2% Virtuoso® Schematic Editing: tutorial NANDZ schematic
Cmd: Sel: 0

Tools Design Window Edit Add Check Sheet Options

e

ST |

mouse L: schSingleSelectPt() M: schHiMousePopUp () R: schfoomFit{l. 0 0. 9%

Then add wires (narrow) to connect all the transistors as required.
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Adding Voltage Sources

X - [Bx]
Cmd: Instance Sel: 0 Status: Ready T=27 C Simulator: spectre 6
Tools Design Window Edit Add Check Sheet Options Help

&[]

)
(]

)

N
&? S Add

e N nstance
Hide | Cancel | Defaults
e
Library | analogLik
e ;

cell wdg

Fd view | symbol
N Hames IVl
8 | |

Wl Array Rows |L Columns | L

Rotate Sideways Upside Down

™ AC magnitude
J--\ AC phase
DC voltage
: Moise file name

Humber of noiseffreq pairs 1]

G mouse L: mousedddPt() M: schHiMousePopUp ()
= | PFoint at location for the instance.

Adding a voltage source is same as adding any other instance.
It can be picked up from the “vdc” cell of the “analogLib”
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Final Schematic of NAND-2

D 2 % K g

SR

tuu. TR
Pt | EEE
> i

x

L -

[ &

mmmmm : schSingleSelectPti) M: schHiMousePopUp i) E: schEoomFit{l.0 0.9)

=" =l

Complete Schematic Diagram and Test Bench of a NAND 2
drawn using the Virtuoso Schematic Editing tool of Cadence

i
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Launching Analog Design Environment

Virtuoso® Schematic Editing: tutorial NAND2 schematic
Cmud: Sel: 0 10

Tools | Design Window Edit Add Check Sheet Options
Analog Environment
Design Synthesis

Diva

Floorplan/Schematics
Hierarchy Editor
Mized Signal Opts.
Schematics

T=27 C Simulator: spectre

Session Selup Analyses Variables Outpuis Simulation Results Tools Help
Design Analyses *—%

# FoS Es. ..o Enzbl
Library tutorial Type e TERSE | ame
Cell  NANDZ B
- riq
View schematic L
Design Variables Outputs [Ej

& Hame Value & Name /S1ignal /Expr Value Plot Sawve March

PREElE=IRN

| O mouse L: schSingleSelectPL() M: schHiMowsePoplp () F: schfoomFit{l. 0 0. 9)

In order to launch the Analog Design Environment, choose
Analog Environment from the Tools menu in the Virtuoso.
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! T 3 CSCE 5730: Digital CMOS VLSI D
NORTH 1EXAS 'gita €sign




3ession
achematic Windowr ...

Jave State ... -

Load State ... -

Save Script. ... \5 Status: Ready T=27 C Simulator: spectre 11
Options ... ession Setup Analyses iables Outputs Simulation Results Tools

Welcome To Spectre ...
What's Hew ...

Reset

Quit

Setup
Design ...
SimulatorfDirectoryfHost ...
. Model Libraries ...
.Temperature
' Stimuli ...
i Simulation Fles ...
Environment ...

A AN A R

Yariahles
Edit ...

L

Outputs

Talue

+H

Name /S1iqnal Expr Value Plot Sawve March

- B X

Help

Drrderis

Fiput !
Copy From Cellviews
Copy To Cellview

Various important menu options in the ADE include

The Analog Design Environment

Outputs

Setup ...

Bdnin

To Be Saved

Fo fro Rgrohosd
To Be Plotted
Save Al ...
Simulation
Metlist and Bun
Run

Stop

Options

MHetlist

Output Log ...
Convergence Aids
Metlist and Debug AHDL

Parametric Analysis ...
Comers ...

Monte Caro ...
Optimization ...

RF

Calculator ...

Results Browser ...

Session, Setup, Variables, Outputs, Simulation, Tools..waveform ...

UNIVERSITY,
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Adding Design Variables

% Cadence® Analog Design Environment (4) =
Status: Ready T=27 C Simulator: spectre 13
Session Setup Analyses Vanables | Outputs Simulation Results Tools Help
) Edit ... .
pestan et nalyses * Click on “Copy from
Library tutorial Tt COuments. .. ... Enzble |° .. . ” .
1y s i il Cellview” to include
el L) CD[]Y To Cellviewr £ | A = =
Vew  schenatic 1ol variables from the cellview
‘ ‘ Xy 2
Design Variables Outputs (B of the schematic
#  Hame Value ‘# Name /Signal /Expr Value Plot Sawve March 7
W ade o/ Analog Desig 0 : : - [
Status: Ready T=27 C Simulator: spectre 13
Session Setup Analyses Varables Outputs Simulation Results Tools Help
Design Analyses '-E;
» IBrs il # Type Arguments. ... Enable :?,EHN
Cell  NaNDZ 'T
View  schematic I ;'; I
Design Variables Outputs [E:
. . #  Hame Yalue #  Meme/Signal/Expr Value Plot Sawe Macch .
Variables copied e
from cellview of
the schematic.
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Adding and Editing Design Variables

N

KDoubIe click on\

launch the Design
Variable Window

any of the
variables to

2

¢

Virtuoso® Schematic Editing: tutorial NAND2 schematic — Cadence® Analog Design Environment (6)
Cond: Sel: 0 Status: Ready T=27 C Simulator: spectre 14
Tools Design Window Edit Add Check Sheet Options Help

& K

Cadence® Analog Design Environment (6) L
SRR (L) T=27 C Simulator: spectre 16 | || A
T o=VOD

Cell HAND2

@2
N |
.2 |
('_J\ Session Setup Analyses Varahles Outputs Simulation Results Tools
« (i [ Design Analyses
L .
| Lib tutorial  |[F Tyee  Arguments........ooo...o
L .

Viewr schematic

Design Variahles

Name ¥alue

0 OK | Cancel | Apply | Apply & Run Simulation

tr
Cload Selected Variahle

wtn

..... ’ tox
J B &g

Hamne toxeq

Value {Expr) |I

“Ad | Delete| Change | Mext| Clear| Find

B Ny B S H

z
o
g
-
5
£
b3
g
=
Py
3
=
g
=
Py
e

O fleSelectPt () M: schHiMousePopUp () E: sevLoadState(’sevSessionk)

>

The Design variables can be added/edited by launching the
“Edit Design Variables” window in the ADE and then giving
values corresponding to the names of the variables.

UNIVERSITY,
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Adding and Editing Design Variables

OK | Cancel| Apply | Apply & Run Simulation Help
selected Variable Table of Design Variahles
Rimerie YOI #  Hame Value
Value [Egpr] n.7 E EpSian 3.9
T wip -wtn
8 toxeqg epsil. .
\/7 Add | Delete | Change | Hext| Clear| Find 9 Lp boxeq.
Add the 10 Ln Lp
11 wp B+*Lp
variable Cellview Variab py B \| copy To 12 Wn 4+Lin

A

When the value is
added/changed, it can be
seen in the table

Don't forget to click “Change”
if you change a value.

Also you can Delete,
Go to the “Next” Variable, “Clear” a
value and “Find” a variable

UNIVERSITY,, o |
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Choosing a Simulator

:r' o L T -.“ 1-..-..u'_.'.;.-,. _-_. Environment n = :D E|
Status: Ready T=27 ¢ Simulator: spectre 3
Session Setup Analyses Varables Outputs Simulation Results Tools Help

Design Analyses '—i{

Library tutorial

Cell NaND 2

View 5

oK | cancel |Defaults|

#

Simulator spectre =
1 wp
2 Wn Project Directory |- fsimulation
3 anj]
4 tr Host Mode #local . remote . distributed
5 1p
B Ln J tsst |
= Hemnais Dieolory |

After the schematic design phase is over, we chose a simulator to
simulate the design. In our case we chose Spectre.

Go to Setup -> Simulator/Directory/Host, and choose

Spectre in the pop-up window, then click OK
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Adding Model Libraries

2% spectre0: Model Library Setup

OK ‘ Cancel ‘Defaults‘ Apply ‘

EEX

Help

‘#Disable |Model Library File

Sarfsies |

Model Library File Section (opt.)

|

Hughed famiade

Change J it P

2% spectre0: Model Library Setup

oK | Cancel ‘Defaults| Apply ‘

finnite
iy
Bty

Browse...

OK | Cancel‘ Apply | Open‘

File

!

..f (Bo up one directory)
Models s
MultikSimulation,
TabHod/

zhdl debugs
class/
eliaskDataPlots /s
examples
1ccd2005
include s
simulation,

Current Directory

]

' Awalmiki /Verilogas

Help‘

#01isable |Model Library File

Section

fandida

Don’t Forget to “Add”
the model file before
clicking “ OK”

Model Library File

sl home swvalnikl Werilogd /ESIME 45nm nominal. dat

Section {opt.)

I Aasrl hone SralnikiVerilogh/BSIMA 45nm nominal. dat

I

\ Add | Delete | Change ‘ Edit File ‘

Disable
i
D

Browse...

Go to Setup - Model Libraries and choose (you can type directly or use

Browse) an appropriate library then click Add (this is important, don't
forget to do it), which adds the model for the chosen model to the

simulation environment.

r( UNIVERSITY,
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Choosing Type of Analysis

»% Choosing Analyses -- Cadence® Analog Design En... EE

Ok ‘ Cancel ‘ Defaults| ﬂpply| Help
Analysis 4 tran .- dc .- ac .~ hoise

A =T - BENS A docmatch S sth

o 3P woenvip - pss

-~ pac -~ pnoise . - pxf - psp

-~ pss -~ gpac -~ gpnoise . - qpxf

~ qpsp

Transient Analysis

Stop Time |5':I

Accuracy Defaults {ernpreset)
| conservative [l moderate | liberal

Enabled l Options... |

Choose the type of simulation, go to Analyses -> Choose...

We choose a “Transient” by clicking on the “tran” radio button.

We also assign a “Stop Time” here it’s 50 which signifies 50 cycles.
Finally click OK.
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Save Options for a State

2%, Save Options

oK Cancel | Defaults | Apply Help
Select signals to output {save) none | selected |Ilvipub _|Ivl [l allpub | all
Select power signals to output (pwr) none | total |devices | subckts | all

Het fovel of suboboudl o oulpsd fnasiiviy

Select device currents (currents) selected | nonlinear W all

3et subcircuit probe level (subcktprobelvl) |I

Select AC terminal currents (useprohes) yes no
Select AHDL variables {saveahdlvars) selected | all
save model parameters info |

Save elements info |

Save output parameters info |

Now go to Outputs -> Save All and click on allpub for signals to save
(default). In general, for large schematics, you

want to save only a subset of signals so that you save computing
resources, but this schematic is small enough that it

Is OK to just save all. Click OK.
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Loading Saved States

»% Loading State -- Cadence® Analog Design Environment (1) E]E|E|
OK | Cancel| Apply | Delete State Help
Cell NAMDZ
Simulator spectre
State Hame
VWhat to Load M Analyses M Varables H Outputs
N Model Setup Bl Simulation Fles H Environment Options
B Simulator Options H Convergence Setup Wavefonm Setup
B Graphical Stimuli Conditions Setup Results Display Setup

A saved state for a schematic contains all the
information that has been saved regarding the
schematic, including the Library, Cell Name, the
Simulator and the information to be loaded.

Just choose the state to be loaded and click “OK”
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Setting up Outputs

2% Cadence® Analog Design Environment (1) |Z||E|E|
Status: Selecting outputs to be plotted... T=27 C Simulator: spectre 3
Session Setup Analyses Variahles Outputs | Simulation Results Tools Help
Design Setup ... LI ses -
: Drulnin i
Library tutorisl # TV ToBe Saved 5 ocoe i Enzble 2
Cell . 1 frm i b Rapchemi o N — aoe
HAND N
To Be Plolted | ggjact On Schematic 'I'H
View schematic Save All ... Sl ¥ ]{YZ 1
st You can specify the
Design Variables o Harnnws B I:Ef
| ‘ Outputs to be plotted or
#  Hame Value #  Mame/Signal/Expr Walue  Plot Sawve M : p p
1 wvoD vl L e e saved from the OUtpUtS
2 tx 10p 2  Igawve YEs .
S load 10t menu option.
4 win 2E20m
5 tox 1. 4n ﬂ L.
L DD Initially you can choose
Select on Sch tic O ts to Be Plotted 1
7 Select on Schematic Qutputs to Be Flo them from the schematic

Then you can use the

0K ‘ Cancel‘ Apply | / Help| ] _
T e OF Outts DH Setting Outputs window
Mame (opt.) |IanE=I #  Name/Signal/Expr Value le tO ad d /ed |t th em.
Expression |average {Iqhoti vout =l n@

Calculator Open

Get Expression ‘ Close ‘

Vill Be M Plotted/Evaluated

Add Delete‘ Change‘ Next‘ MHew Expressmn|
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Choosing Outputs from Schematic

2% Virtuoso® Schematic Editing: tutorial NAND2 schematic -- Cadence® Analog Design Environment (1)

Cmd: Sel: 1 Status: Selecting outputs to he plotted... T=27 C Simulator: spectre 2

Tools Design Window Edit Add Check Sheet Options Help For ChOOSIng Voltage
W Click on the wire.
&8

2 For choosing current
- click on the

point/node.

A choice for a current
node is shown by a
elliptical ring and
choosing a voltage
changes the color of
the wire. These colors

I correspond to the

0 color of corresponding
- line plotted in the

=y simulation.

Ij .

Q Ta;zzifl;‘:J;;TSingleSelectPt() M: schHiMousePopUp () F:hiZoomRelativeScale (getCurrentWindo

UNIVERSITY, o |
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Starting Simulation

»% Cadence® Analog Design Environment (1) EJE|E|
Status: Selecting outputs to be plotted... T=27 C Simulator: spectre 3 An al yS IS
Session Setup Analyses Varables Outputs Simulation | Resulis Tools Help S etu p
i Metlist and Run
Design < ‘DH
Run
# £ 1
HU \Library tutorial Type L) § "THCFIH
ol . 1 tren [ Options oc
HAND Netlist |
: : T
DeS I g N Setu p View  schematic Output Log ... XYz Netl ISt
_ ] Convergence Aids of
Design Variahles Netlist and Debug AHDL [E»f and Run
#  Name Value #  Name/Signal. Debug AHDL ave March ;
HU VoD T00m 3 Ignl YES j}/
2 tr 10p 4  tdHL YES
1 3 Cload 10f 5 tdLH YES
DeS I g n 4 wkn 220m £ a yes all no
I 5 tox 1. 4n T kb yes all U H
Variables Setu Pl epsilon 3.9 5 Igpt yes

v Outputs Set

= Select on Schematic Outputs to Be Plotted

When all the setup is complete, you are ready for the Simulation.

Simulation can be started either from the menu as shown or by
clicking the “Green Traffic Light” button from the right hand toolbox
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Simulation Results

When the Simulation is done and

there are no errors in the Simulation.

You can see a window with the
results of the simulation as shown
here.

With an error free simulation, next
you can see the “Waveform
Window”

If you have any errors, you can
always go back to the “Virtuoso
Schematic Editor” window and
correct them

Always remember to do a “Check
and Save” when you are done with
any correction.

NORTH TEXAS

2% Jusr1/homelvalmiki/VerilogA/simulation/NAND 2/spectre/schemati. ..

File Help

[command line:
fusrlfeds/ICE033 /tools. laxBe fspectres/bindspectre -env artist5. 0.0
+escchars +log .. fpsf/spectre. out +inter=mpsc %
+mpssession=spectrel 29774 1 -format psfhin -raw .. fpsf
input. scs
spectre pid = 29950

Loading susrlfeds/ICE033/tools. InxBE spectreslib/cmis/3. 0/ libinfineon s

Loading /usrlfeds/IC5033/fools. LnxBE spectreslib/cmi/3. 0/ libnortel sh.

Loading /usrl/feods/ICE033/tools. a6 fspectre flib/fcmi 3. 0/ Libphilips_sk

Loading /usrlfods/ICE033/tools. lnxBE fspectre flib/fcmi 3. 0/ libstmodels s

spectre (wer. 5.0.33.021904 -- 19 Feb Z004}.

Includes RSA BSAFE(R) Cryptographic or Security Protocol Software fronm
Security, Inc.

Simulating " input. scs' on lnx-eliask at 6:55:38 PM, Sun Sep 11, Z2005.

Warning from spectre during initial setup.
nl: ' Ckappas' 10 m¥ is wnuswally small

nl: "Ckappad' = 10 m¥ iz vnwsually small
nl: "Ckappas' = 10 m¥ is wnuswally small
nl: "Ckappad' = 10 m¥ is wnuswally small
nZ: "Ckappas' = 10 m¥ is uwnuswally small

Further occurrences of this warning will he suppressed.

Circuit inwventory:
rnodes 5
equations 24
bsimd 4
capacitor 1
quantity &
vsource 3

Warning from spectre
L warnings suppressed

Entering remote command mode wsing MPSC service (spectre, ipi, w0.0,
spectrel_29774 1, .
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Waveform Window

Waveform Window 2 -- Cadence® Analog Design Environment (1)

Window ZFoom Axes Curves Markers Annotation Edit Tools

ions 1 i Transient R

3.8n
time { s |

UNIVERSITY, £ - :
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Waveform Sub-windows

2% Subwindows (window:5)

OK | Cancel Help

Choose Subwindow(s)

2 Waveform Window 2 -- Cadence® Analog Design Environment (1)

Title Display Update

Window Zoom Axes Curves Markers Annotation Edit Tools

1  Expressions 1 o or

_
|
Add | Delete On r
Enable Results Update = Disaly Its Update
360

@68

In case of multiple expressions generating
numerous sub-windows, you can get the

sub-window you want by choosing /\/
Windows->Subwindows =

Which launches the sub-window

management box. Just turn “ON” or “OFF”
the display for the particular window or just
“Add” or “Delete” them. Then press “OK”

¢

mouse L:awwMouseSingleSelect M:

UNIVERSITY,
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Switching Axis Modes

Waveform Window -- Cadence® Analog Design Environment (1)

Window Foom Axes Curves Markers Annotation Edit Tools

You can also switch multi axis to
single axis mode in a sub-window.

Waveform Window -- Cadence® Analog Design Environment (1) @
Active &5

Help

/\éf in T i ' 116
Window ZFoom Axes Curves Markers Annotation Edit Tools

}/_

mo L:awvMouseSingleSelectPLCE () M:
>

Tool box icon for
SWitC h i n g Axes mouse L:awvMouseSingleSelectPECE () M: F: awviSwitchiesModelE ()

>
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The Calculator

2% Waveform Window -- Cadence® Analog Design Environment (1)

Window Aoom Axes Curves Markers Annotation Edit Tools The CaICUIator IS an eXtremer
' efficient tool that can be used
to perform various operations.

Transient Response

You can launch the calculator
by clicking on the calculator
icon on the tool box on the left
of the “Waveform Window”

It can be used to draw and plot
the desired waveforms and
Evaluate Buffer | Display Stack T evaluate and set up variables
browser|| vt | it || laste| xey | dwn| up || Sto | rol Special Functions and expres sions.

wave v if clear clst | app sin | asin | mag | In | exp | abs

family Vs is enter undo | eex cos | acos | phase| logl0| 10™x| int An effl C | ent u Se Of th e

emplot || wvdc | idc 7 ] 9 tan | atan | real | dB10| y**x | 1/ CaICUIatOr can make a |Ot Of

plot ap opt + 4 a [ sinh | asinh | imag | dB20 | zx**2 | sqrt . f f t th

printvs Vi var * 1 Z 3 cosh | acosh, Tl e I3 T4 dl erence O e Way you .
= [ r | o ot || tanh | atann design and analyze the circuits.

UNIVERSITY, o |
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Using the Calculator

2% Calculator g@@

Window Memories Constants Options

Using the calculator we can
save the data from a
waveform and use it later.

wavewbslil {]l]:

Nienlay Stark s e e |
% Waveform Window -- Cadence® Analog Design Environment (1) E@@ 1

Evaluate Buffer

Click on “wave” in
“Calculator”

hrowser vl
Window Foom Axes Curves Markers Annotation Edit Tools Help

Wave Wi
faumily 3 Expressions 1
erplot 2. Click on the desired wave
plot on the “Waveform Window”
wave 3. Click on “printvs”
“printvs” 4. In the “Printvs Range”

window give the range.
5. Click OK

mouse L:awviouseSingleSel M: R:awvileleteMenuCE (

Chose the waveform

6. You will get the “Results

/s Printvs Range Dis P | ay” window
Ok Cancel | Defaults | Apply Help
From |500m To |1.0 linear By ..

UNIVERSITY,
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Saving Waveform Data

After giving the range in the

Window Expressions Info . Help | 7 “ PrlntVS Range,, WlndOW, you
YOO awerage (((({abs (({{{{getData("pl:igh" Fresult "tran") + ge—‘ ClICk “ OK" you get the
S0 29 7in C . . .
gég.im giggn adjomlng Results DISpIay
£30 6n 37 23 Window”
540, Bn 40, 05n i
E5im 43.03n |
el e I The data from this window can
s - ‘ be either printed directly to a
10 o ca. o6n | printer or it can be printed to a
622, dm 69 36n i
632 T 74, 03n ‘ file.
642 Om 78 95n |
653, Im 84 14n ,
663, I & Choose,
£73. 5m
683, Tn = e f o _ ) . :
693. I G G | i S 1 | Print To > File option and give
;éj;i ::: -fr":m window 7 — |  Number of Characters Per line IE':E th e f| | e name.
;ji SE - Printer o illi'f -P | . . .
755 1n SFE  Fio name [FADE P Tor || Your simulation data is now
775 5n wpomere saved!
785 Tn 183n
795 On 193 fn
ans lm 204. 8n B
I( UNS%%%S CSCE 5730: Digital CMOS VLSI Design




Using Parametric Analysis

¢ Cadence® Analog Design Environment (1) E]E|g| i .
Status: Reaty rarc smuanspecwe. 3| PAFaMetric Analysis allows you to
Session Setup Analyses Variables Outputs Simulation Results :Z::“Emc malﬁisl-llflp ru n au tO m atl C S | m u I atl 0 n S fo r Over
o "= wmws.e== | grange of values of a specified

Library tutorial #  Type Aroquments. ... Mm?te-(“»“jl:

- S T i on (HJEUmlzau param eter i

View schematic Calculator .

bosign Variabios outputs | PESUIS B You can launch the parametric
Waveform| .

# Wame Vel [¢ Wene/Sigalfr  Value EResults D analysis tool from the Cadence®
e f - : Analog Design Environment Tools
4 ot 220n Py g;gegp = i menu.

5 tox 1.4n 5 tdlH 85. 48p }

6 epsilon 3.9 B & vEes &

» Results in .../home/valmikiVerlogAfsimulation/MAN D2 fspectre/schematic C h O O S e

Tools - Parametric Analysis

FBEX
Tool Sweep Setup Analysis Help @ 9 SpECIfy the 113 Varlable Nam en On
which you want to run the

X Parametric Analysis - spectre(0): tutorial NAND2 schematic

Sweep 1 variable Hame ©°% Add Specification . . .

analysis. Specify it's range and
Range Type T pom (L oo (B Total Steps and click “OK”
Step Control At Total Steps |10

UNIVERSITY,r o |
ORTHTEXAS CSCE 5730: Digital CMOS VLSI Design

¢



Setting up Parameter

» Parametric A nalysis - spectre(0): tutorial NAND2 schematic [Z| [E| rz|

Tool Sweep Setup |F|.r|alysis
Pick Hame For Variable I Sweep 1 ... \ B[=/e9
============agd New Variable To Top Help |
Sweep 1 Add Mew Variable To Bottom \e | EO% d SpeciTicay
Delete Variable ... o
Delete Range Specification ... A 0 tr
Range TYPe | olete Al Range Specifications h To “ GLozd
il Doud (e 1q :i
Step Control Select All Range Specifications epsilon
] Dpapdeal AF Hopeee Dnsoifiondiong :Zieq
Lp
In order to run Parametric Analysis chose the G
variables from
Setup > Pick Name For Variables = Sweepl
And click “OK”
This will fill the variable field.
You can choose multiple parameters for multiple
SwWeeps.
UNIVERSITY, R -
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Performing Parametric Analysis

{ fusr1 fhome/valmiiNVerilog/simulation/\a.... [2[E[]

Parametric Analysis - spectre(0): tutorial NANDZ schematic

Tool Sweep Setup Analysis Help 9
start File Help | 10
A - TR . Add Suecification .| | W7TTTTTTTTTTITC start of parametric run Sep 12 13:
Sweep 1 Hrap sle Hame | -5 peciiication generate netlist. ..
LT .. .successful.
F Pamg How 1A 50 £ OTIT simulator input file. ..
Range Type R To R
ge Typ Conthu -3?3'3'333:?1- i
Show Sweep Sets i ulator 1f needed. ..
Step Control rowa 3teps csuccessful.
= LI 2. ..
simpation completed successfully.
9 parametric simulations remailning.

Setting tox = 1. 4EGEEEEGEEEGRGRETe-09
conpose simulator input file. .

Waveform Window 2 -- Cadence® Analog Design Environment (1)

- .. .successful.
Active 11 start simulator if needed. ..
Window Zoom Axes Curves Markers Annotation Edit Tools Help . .. - successful.
simulate. . .

simulation completed successfully.
R : 8 parametric simulations remailning.
Expressions 1 Setting tox = 1.5333333333323322-00

”}I{" lator input file. ..
cessful.

ﬁ tor if needed. ..

& cessful.

simulate. . .

Run Parametric Analysis by
choosing Analysis - Start.

This gives the Analysis status
and the final result waveform.

mouse L:awwMouseSingleSelec M: E: awwileleteMenuCE ()

>
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Summary

* In this presentation we learnt how to use the
various components of the ICFB design
environment of Cadence®

e We also discussed in detall the features of

— The Virtuoso® Schematic Editor

— The Calulator tool,

— The Waveform Window and
— The Parametric Analysis tool.
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